
 

 

ACADAMIC CELL, NPS GDC Women(A) 
Chittoor  

Proceedings of the Principal, NPS Govt. Degree College for Women(A), Chittoor 

Present: Dr. K. Manohar 

 
Rc.No. COM/GEN/ 01 /NPSGDCW/UG-BoS/2025-26 dt. 28-09-2025 

 

         Subject:  NPS GDC Women(A), Chittoor – UG Board of Studies (BoS) –   Nomination of Members –    

                          Orders issued.  

         Ref.: 1. UGC Guidelines of for Autonomous Colleges – 2023. 

                  2. Proc. of the VC No: SVU/C-III (3)/BoS/Smt. N.P.S. Govt. Coll/chi/2025 

*** 

Order 
 

The Principal, NPS GDC Women(A) pleased to inform that to conduct Board of Studies Members meeting in the subject of 

commerce B.Com CA, Gen, BBA & BFSI for the academic years 2025-26 to  2027-28 to the concerned course or till the date of your 

retirement / transfer whichever is earlier. Following the norms of the UGC Regulations, 2023. 

 A copy of the list of members of the Board of Studies of Commerce is herewith enclosed for your information. Your 

acceptance is a pleasure to serve in the board and the college expects your valuable advice / suggestions during the above period. 

S.NO Name & Designation Chairperson/ Member Signature 

1 Dr. T.Vinila Chairperson  

2 Prof.P.Mohan  Reddy University Nominee   

3 Prof.Raghunadha Reddy University Nominee  

4 Dr.K.Nandeeswaraiah Subject experts by University  

5 Dr.V.Maslamani Subject expert   

6 Dr.k.Sankar Reddy Subject expert   

7 Sri.A.M.Narendra kumar Industrialist  

8 Dr.J.Ramadevi Member  

9 2.N.Kasturamma Member  

10 G.Yamuna Alumni  

 

The above members are requested to attend the BoS meeting for the first autonomous UG-Batch 2025-26 and 

share their valuable, Suggestion on the following functionaries. 

a) Prepare the syllabi for the subject keeping in view the objectives of the College, interest of the stakeholders and national 

recruitment for consideration and approval of the IQAC and Academic Cell. 

b) Suggest methodologies for innovative teaching and evaluation techniques. 

c) Suggest the panel of names to the Academic Council for appointment of Examiners 

d) Coordinate research, teaching, extension and other activities in the department and the college. 

e) Suggest CLO,PLO, and subject experts to develop question bank in compliance with bloom’s 

Taxamony 

f) The above said members are requested to bestow their services for the successful organization of the events whenever 

scheduled. 

 

                                                                                                                                         Principal  



 

 

 
 

Department of Commerce 
ACADEMIC YEAR  2025-2026 T0 2027-28 

BOARD OF STUDIES MEMBERS 
 

 
            

 
                       

 

 

 

 

 

 

 

 

 

 

S.NO                  Category Name & Designation Chairperson/ Member 

1 Chairperson Dr. T.VINILA 

Lecturer in Commerce 

Smt.N.P.S GDC For 

women(A) Chitoor. 

Faculty 

Mobile: 8897799816 

thadipallivinila@gmail.com 

2 Members of the 

Department 

 

1.Dr.J.Ramadevi 

Lecturer in Commerce 

2.N.Kasturamma 

Lecturer in Commerce 

 

Members 

Mobile: 9177639191 

Email: jaanujeswi@gmail.com 

Mobile:9492067954 

Email: kasturamma05@gmail.com 

3 One expert from 

to be nominated by 

the Vice-Chancellor 

Prof.P.Mohan  Reddy 

Dept.of Commerce 

SVU College of CM & 

CS 

Tirupathi 

University Nominee 

Mobile:9849063909 

Email:dr.pmohanreddy@gmail.com 

4 One  Experts in the 

Subject nominated by 

Vice-Chancellor   

Prof.Raghunadha 

Reddy 

Dept.of Management 

SVU College of CM & 

CS 

Tirupathi 

University Nominee 

Mobile:9346234167 

Email:dr.reddy@gmail.com 

5 One  Experts in the 

Subject from outside 

the college to be 

nominated by 

University 

Dr.K.Nandeeswaraiah 

Lecturer in Commerce 

SVCR Govt. Degree 

College 

Palamaner 

Subject experts by University 

Mobile:9440396477 

Emai:knadeeswae@gmail.com 

6 Two Experts in the 

Subject from outside 

the college to be 

nominated by 

Academic council 

1.Dr.V.Maslamani 

Lecturer in Commerce 

GDC Pakala 

Tirupathi dt. 

2.Dr.k.Sankar Reddy 

Lecturer in commerce 

GDC,Vedurukuppam. 

 

 

Mobile:9290198731 

Email id:vm4606@gmail.com 

 

 

Mobile: 9866415051 

Email id :sankar.nali@gmail.com 

 

mailto:jaanujeswi@gmail.com


 

 

 

    

Signature of the Chairperson         Signature of the BOS Members 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7 

 

Representative 

from the Industry/ 

Corporate Sector 

A.M.Narendra kumar 

District Tourism Officer 

Chittoor. 

Mobile: 9441392480 

Email: 

amnarendrakumar@gmail.com 

8 One Meritorious 

Alumnus 

G.Yamuna 

Guest faculty  in 

Commerce 

Smt.N.P.S GDC For 

women(A) Chittoor 

 

Mobile: 9502377593 

Email 

id:yamunabujji1984@gmail.com 



 

 

 
 

Department of Commerce & Management 

ACADEMIC YEAR  2025-2026 

 
BOARD OF STUDIES MEMBERS  

                                                   MINUTES OF THE MEETING 
UG B.COM HONOURS GENERAL – SEMESTER I & II 

 

 

The 1st meeting of BOS in Commerce to be held on 30-10 -2025 at 11.00AM 

 

      Agenda: 

1. To discuss 

2. Approval for UG Course structure of Commerce 

3. Approval for changes in the UG B.Com Honors General I Semester paper entitled Financial 

Accounting – I and Business Organisation and Management syllabus, Semester – ii model question 

paper and blue print. 

4. Panel of question paper setters and examiners. 

5. Pedagogy of Teaching – learning as per UGC guidelines 

6. Additional Inputs to the Curriculum 

7. Internal assessment component and additional credits for extra - curricular activities. 

8. Evaluation and assessment pattern. 

9. Introduction of new certificate and diploma courses 

10. Other academic and extra-curricular activities of the department 

11. Any other proposal with permission of the chair. 

 

             Signature of the Chairman          Signature of the BOS Members                                                                                                                                                     

          

 

 

 

 

 



 

 

 
Department of Commerce  

ACADEMIC YEAR  2025-2026 

 

Resolution of the BoS Meeting for  

UG B.Com Honors General I & II Semesters 

 
In the present BOS meeting the following resolutions were made and unanimously approved by the committee. 

The decisions / changes wherever necessary, taken at college level may be adopted in the consecutive academic 

years on the date of BOS meeting conducted 30-10-2025, 11:30 am. 

 Resolutions of the Meeting :  

   It is resolved unanimously 

 
1. The college was conferred with autonomy by the UGC in the month 04-09-2024. Subsequently, the 

college submitted letters to the parent university(SVU), UGC and to the Govt. of AP for constitution of 

Statutory Bodies and release of notification by the affiliating university. The Registrar, S.V. University issued 

notification and directed to implement autonomy from the academic year 2025-26. The college prepared its own 

academic schedule after the conferment of autonomy. Accordingly, the college has been implementing 

autonomy for I year degree I & II semester students from the date of issuance of notification on adhoc basis 

following the academic regulations of the parent university and covered the prescribed syllabus in the first  

semester by making certain changes. The syllabus, course structure, model question papers and blue print are 

placed before the committee for ratification. 

2. As per the academic schedule for I semester of I year students was started on 22-09-2025 and the academic 

instruction has been given to the students as per the syllabus designed by the internal BOS members. It is 

placed before the committee for constructive suggestions for further improvement keeping in view the local 

needs / market demand / industry-needs / employment generation as per the UGC Regulations 2023. 

 

3. Resolved to ratify the panel of question paper setters nominated for UG I year semester I Examinations. 

4. Resolved to follow the pedagogy of teaching / learning strategies as per the UGC guidelines. 



 

 

5. Resolved to use additional inputs to enrich the curriculum and enlighten the students on academic 

performance. 

6. To include internal assessment components and additional credits for extracurricular activities of the 

students. 

7. To follow the evaluation and assessment pattern strictly adhering the UGC norms and guidelines. 

8. To introduce new certificate and diploma courses related to subject and other courses deemed to be 

useful for the students. 

9. To take the valuable suggestions of the BOS on academic and extra-curricular activities to be taken up at 

department level for strengthening the academic instruction to the students. 

10. If any discussion related to academic matters including extracurricular activities may be included as the 

last resolution. 

 

Signature of the BoS Chairman                   Signature of the BOS Members 

         

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 
                 

Department of Commerce 

APSCHE COURSE STRUCTURE  

FOR B.COM GENERAL ACADEMIC YEAR  2025-2026 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 



 

 

 
     DEPARTMENT OF COMMERCE 

                                     I  B. COM HONOURS GENERAL 

                                      SEMESTER - I 

                                   COURSE STRUCTURE 

Sl. No Course Codes Course Internal External Max.Marks Working 

Hours 

 Credits 

1 25BCG101T Financial Accounting - I 30 70 100 4 4 

2 25BCG102T Business Organization and 
Management 

30 70 100 4 4 
 

3 25 BCS101S 
25BCS101L 
(skill paper) 

Introduction to Artificial 
Intelligence 

30 70 100 4+2 6 

                        I  B. COM HONOURS GENERAL 

                                                              SEMESTER - II                              

                                    COURSE STRUCTURE 

Sl. No Course Codes Course Internal External Max. 

Marks 

Working 

Hours 

 Credits 

1 25BCG201T Financial Accounting - II 30 70 100 4 4 

2 25BCG202T Business Economics 30 70 100 4 4 
 

3 25 BCS201S 
25BCS201L 

Artificial Intelligence 30 70 100 4+2 6 
 

 

              Signature of the Members     Signature of the BOS Chairman 

 

 

 

 

 



 

 

 

          DEPARTMENT OF COMMERCE 

B.COM HONORS GENERAL 

SEMESTER-I 

Programme Outcomes (POs) 2025-2026 

1. PO1: Domain Knowledge: Acquire a detailed knowledge and general understanding of the Concepts 

and principles of selected areas of study in the core disciplines of Commerce 

2. PO2: Critical thinking, and Problem-solving: Acquire skills in organizing, analyzing,          

Evaluating, and presenting information. Able to analyze issues logically, consider         

Different options and viewpoints make decisions and act with flexibility, adaptability,         

And   creativity 

3. PO3: Communication skills: Able to communicate effectively, analyze concepts and           

Participate in healthy arguments and portray skills in communication and in writing          

Possess skills related to banking and other business 

4. PO4: Computer Literacy: Able to make appropriate and effective use of information and          

Information technology relevant to their discipline, acquire proper knowledge regarding          

The Software used in the calculation of Taxes, GST, and Tally useful in the banking and          

Business sector 

5. PO5: Moral and ethical awareness: Ability to embrace moral/ethical values, formulate a           

Position/argument about an ethical issue from multiple perspectives, and use ethical          

Practices in all work 

6. PO6: Teamwork and Leadership: Able to work constructively, cooperatively, effectively, and    

respectfully as part of a team, Exhibit qualities associated with leadership such as          

Accountability, integrity, respect, and self-reflection 

7. PO7: Innovative, Project and Entrepreneurial Skill Development: Function as an individual, and as a 

member or leader in diverse teams and in multidisciplinary settings. Become an    entrepreneur by 

acquiring technical, communicative, problem solving, and intellectual skills. 

 



 

 

8. PO8: Independent and Life-Long Learning: Demonstrate the ability to acquire knowledge and business 

skills, the capacity for self-directed activity and the ability to work independently. 

 

                                            Program Specific Outcome (PSO) 

PSO 1. This programme provide Students to become a Computer based   Accountant in any Business 

organisation 

PSO 2.This programme is use full for B.Com graduates to prepare e.filing income   tax scheduled and also 

get job in this area. 

PSO 3.This programme will give subject skills within various disciplines of commerce, business, 

accounting, economics, and finance, auditing and marketing and get jobs in these areas 

PSO 4. This programme will provide to students to become success in competitive exams for Pursuing 

professional courses CA, CS, ICWA and staff selection commission. 

PSO 5.This programme is use full to students to become successful in Junior Accounts officers which only 

met for B.Com Graduates. 

      PSO 6. This programme provides jobs as programmer, soft skill developer and   Computer  

     operator 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 
          DEPARTMENT OF COMMERCE 

B.COM HONORS GENERAL 

SEMESTER-I FINANCIAL ACCOUNTING –I 

 

Name of the Programme  : B.Com 

Name of the Specific Programme : General 

Semester    :  I 

Name of the Course (Paper)  :  Financial Accounting –I  

Paper Code    :  25BCG101T 

Course Outcomes   : At the end of the course students able to 

 

CO1  Understand the basic concepts of financial accounting. 

CO2 
Analyse the accounting process 

CO3 Enable the students to understand the various methods of depreciation and its 

calculation 

CO4 Examine the impact of provisions and reserves on profitability of business 

CO4 Workout with final accounts and assess the financial position of the concern. 

         

                                                                                 Signature of the Internal BOS Members 

1. 

2. 

3. 

4. 

5. 

 



 

 

 
          DEPARTMENT OF COMMERCE 

B.COM HONORS GENERAL 

SEMESTER –I: COMMERCE PAPER – I 

FINANCIAL ACCOUNTING - I 

 

      Credits: 04                 Course code: 25BCG101T        Teaching Hrs/Week : 4 

 

____________________________________________________________________________ 

 

SYLLABUS 

 

 

Course Objectives: 

After completion of the course, the student will be able to:  

 Understand and explain the foundational principles, concepts, and process of accounting, including 

classification and rules of debit and credit;  

 Record and process business transactions through journals, ledgers, subsidiary books, and correct errors 

through rectification entries;  

 Apply and compare different methods of depreciation and amortization to account for asset value 

reduction;  

 Identify and distinguish between provisions and reserves and apply their treatment in final accounts with 

suitable adjustments; and  

 Prepare accurate final accounts (Trading, Profit & Loss, and Balance Sheet) incorporating necessary 

adjustments. 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 
SYLLABUS 

Unit – I: Introduction to Accounting  

Meaning– Definitions -Objectives – Functions – Book keeping and Accounting – Branches of Accounting - 

Advantages and Limitations –GAAP- Accounting Concepts and Conventions –Accounting Cycle- Double Entry 

Accounting System- Classification of Accounts - Debit and Credit Rules. (Theory)  

 

Unit – II: Accounting Process  
Journal –Ledger – Subsidiary Books - Single, Double and three Column Cash Book - Preparation of Trial 

Balance- Rectification of Errors (Including Problems)  

 

Unit – III: Depreciation & Amortization  
Meaning and Causes of Depreciation & Amortization – Depreciation Vs Amortization- Methods of 

Depreciation: Straight Line – Written Down Value – Annuity and Depletion Method (Including Problems). 

 

Unit – IV: Provisions and Reserves  
Provisions and Reserves – Meaning – Objectives – Types of Provisions and Reserves – Differences between 

Provisions and Reserves – Accounting Treatment – Journal Entries – Adjustment in Final Accounts – Impact on 

Profit – (Including Problems).  

 

Unit – V: Final Accounts  

Preparation of Trading Account, Profit & Loss Account and Balance Sheet with adjustments (Including 

Problems)  

 

 

References:  

 Jain, S. P., & Narang, K. L. (n.d.). Accountancy. Ludhiana: Kalyani Publishers. 

 Arulanandam, M. A. (n.d.). Advanced accountancy. Mumbai: Himalaya Publishing House. 

 Goyal, V. K. (n.d.). Financial accounting. New Delhi: Excel Books. 

 Tulsian, P. C. (n.d.). Accountancy–I. New Delhi: Tata McGraw Hill Publishing Co. 

    

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

      

 
          DEPARTMENT OF COMMERCE 

B.COM HONORS GENERAL 

 

SEMESTER –I: COMMERCE PAPER – I 

FINANCIAL ACCOUNTING - I 

   Course Code:    25BCG101T         

BLUE PRINT FOR THE MODEL PAPER 

 

 

S. 

NO  
 

 

Type of 

Question  
 

 

To be given in the Question Paper  
 

 

To be answered 
 

No. of 

Questions 
 

Marks 

allotted to 

each 

question 
 

Total 

Marks  
 

No. of 

Questions  
 

Marks 

allotted 

to each 

question  
 

Total 

Marks  
 

1 

 

Section - A 

(Short 

Questions) 

10 5 50 5 4 20 

2 Section - B 

(Essay 

Questions) 

10 10 100 5 10 50 

Total Marks 

 

150 Total Marks 70 

 

 

 

 

 

 



 

 

 

I B. Com HONOURS (GENERAL) 

SEMESTER –I: COMMERCE PAPER – I 

     FINANCIAL ACCOUNTING – I     
 

                                                                                                                               Code: 25BCG101T 

 

BLUE PRINT FOR THE QUESTION PAPER SETTING 

 

 

Chapter Name   Short questions 

5 marks   

Essay questions  10 marks  

 

UNIT – I 2 2 

UNIT – II 2 2 

UNIT – III 2 2 

UNIT – IV 2 2 

UNIT – V 2 2 

 10 10 

 

          Signature of the Chairman     Signature of the BOS Members 

        

 

 

 



 

 

 

I B.Com (GENERAL) 

SEMESTER –II: COMMERCE PAPER – I 

FINANANCIAL ACCOUNTING – I 

                Time : 3  hrs                  Code: 25BCG101T                    Max Marks : 70M  

________________________________________________________________________ 

MODEL QUESTION PAPER 

Answer any Five of the following Questions     5X4 =20 Marks 

1.Define Accounting. Explain its objectives. 

2.Distinguish between Bookkeeping and Accounting. 

3.Explain the Importance of GAAP. 

4.What is the Accounting Cycle? 

5.Describe Debit and Credit note 

6.Define Depreciation. State its causes. 

7.What are Provisions? State their objectives. 

8.Define Reserves. What are their types? 

9.What is a Ledger? Write its advantages. 

10.Explain the rules of Debit and Credit. 

SECTION – B 

Answer ONE question from each Unit                                                      (5×10 = 50 Marks)                                                                                                                                                                        

 

UNIT – I 

Q11. Explain the advantages and disadvantages of accounting 

                                           OR 

Q12. Define accounting concepts and conventions 

 

 

UNIT – II 

Q13 .Journalize the following and prepare the Ledger Account of Cash: 

Started business with cash  Rs.30,000 

Purchased goods for cash Rs 5,000 

Sold goods for cash Rs 7,000 

Paid rent Rs 1,500 

Received cash from Raju Rs .3,000 



 

 

                                   OR 

Q14. Explain the types of subsidiary books 

 

UNIT – III 

 

 

Q15. Define causes of Depreciation  

                                     OR 

Q16. Sriram purchased a machine for Rs.20000 on 1-1-16. Its estimated life is 10 years. The scrap value of the 

machine after 10 years is Rs.2000. the Depreciation was provided  on Fixed installement method .your are 

Required to calculate annual Depreciation , Rate of Depreciation also show a machine account for First 5 years  

 

UNIT – IV 

Q17. Explain the Types of Reserves  

                              OR 

Q18. Pass Journal Entries for: 

Creating Provision for Bad Debts Rs 2,500 

Creating General Reserve Rs .4,000 

Using Provision for Bad Debts Rs 1,200 

Transferring Rs 3,500 to Capital Reserve 

 

UNIT – V 

Q19. From the following Trial Balance, prepare Trading, Profit & Loss Account and Balance Sheet: 

 

 

 

 

 

 

 

 

 

Adjustments: 

Closing Stock Rs 20,000 
Outstanding Salaries Rs 1,500 
 
 

Particulars Amount (Rs) 

Opening Stock 15,000 

Purchases 40,000 

Sales 80,000 

Wages 3,000 

Salaries 6,000 

Rent 2,500 

Debtors 25,000 

Creditors 18,000 

Capital 60,000 



 

 

                                                           OR 
Q20.What is the final account ? Explain their features and objectives 

             Signature of the Chairman          Signature of the BOS Members  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

Department of Commerce 

I B.Com (GEN) SEMESTER –I: COMMERCE PAPER – I 

BUSINESS ORGANIZATION AND MANAGEMENT 

 

 

      Credits : 04                     Teaching Hrs/Week : 4 

__________________________________________________________________________ 

SEMESTER-I 

COURSE 2:BUSINESS ORGANIZATION AND MANAGEMENT 

Course Objectives 
This course is designed to: 
- Acquire conceptual knowledge of business and the formation of various business organizations. 

- Provide insights into mergers, acquisitions, CSR practices and quality management concepts.  

- Develop understanding of key management functions. 

- Understand motivation and leadership theories. 

- Understand line and staff relationships and gain insights into the control process. 

 

Course Outcomes(COs) 

Upon successful completion of this course, students will be able to: 

CO1: Identify and differentiate various forms of business organizations including P4 models and franchising 

systems. 

CO2: Analyze the impact of business environment factors like mergers, acquisitions, and CSR on 

organizational sustainability. 

CO3: Demonstrate knowledge of key managerial functions including planning, delegation, decision-making, 

and organizational structure. 

CO4: Apply motivation and leadership theories to workplace scenarios and assess their implications on 

employee performance. 

CO5: Develop foundational skills in business analysis using tools such as SWOT, TQM, and quality circles. 

 

 

 

 

 

     25BCG102T 



 

 

                                                 

Department of Commerce 

I B.Com (CA) SEMESTER –I: COMMERCE PAPER – I 

BUSINESS ORGANIZATION AND MANAGEMENT 

 

 

 

      Credits : 04                    TeachingHrs/Week:4 Theory 

 

SYLLABUS 

Unit I: Business: Forms of Business Organization - Sole Proprietorship, Partnership, Joint Stock 

Companies & Co-operatives and their Characteristics, relative merits and demerits- Difference between 

Private and Public Company- Concept of One Person Company-  

 

Unit II: Business Dynamics: 

Mergers and Acquisitions- Business Takeovers- Corporate Social Responsibility (CSR)- examples with 

reference to AP state, Concept of Quality-Total Quality Management (TQM) 

 

Unit III: Management: 

Functions of Management- planning – Short-term & Long-term Planning- Decision Making- Delegation 

of authority- Decentralization- Departmentation - SWOT analysis. 

 

Unit IV: Motivation: 

Introduction – Definition – Concepts of Motivation – Theories - Maslow’s Need Hierarchy Theory- 

Theory X and Theory Y–Leadership concept –Styles of Leadership -Theories of leadership: Traits theory, 

Behavioral Leadership Theory, Situational Leadership Theory. 

 

Unit V: Staffing and Control 

Meaning and Definition of Staffing - Line and staff relationship - Control: meaning and importance- 

process of control-control techniques- budgetary control. 

 

Activities: 

- Assignment on business organizations and modern business. 

     25BCC102T 



 

 

- Group Discussion on factors that influence plant location 

- Seminars on different topics related to Business organization 

- Case studies of successful corporate/business heroes. 

 

Reference Books: 

Gupta.C.B.(2014).Business organization, Mayur Publication. 

Singh, B.P &Chhabra, T.N.(2014). An introduction to business organization & management. Kitab Mahal. 

Sherlekar,S.A.,&Sherlekar,V.S.(2000).Modern business organization& management: Systems approach. 

Himalaya Publishing House. 

Bhushan,Y.K.(YearUnknown).Business organization. Sultan Chand &Sons. 

Prakash, J. (Year Unknown). Business organisation and management (Hindi and English ed.). Kitab Mahal 

Publishers 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

Department of Commerce 

I B. Com HONOURS GENERAL 

SEMESTER –I: COMMERCE PAPER – I 

    BUSINESS ORGANIZATION AND MANAGEMENT                       

    Code: 25BCG101T 

BLUE PRINT FOR THE MODEL PAPER 

 
 

S. 

NO  
 

 

Type of 

Question  
 

 

To be given in the Question Paper  
 

 

To be answered 
 

No. of 

Questions 
 

Marks allotted 

to each question 
 

Total 

Marks  
 

No. of 

Questions  
 

Marks 

allotted to 

each 

question  
 

Total 

Marks  
 

1 

 

Section - A 

(Short 

Questions) 

10 5 50 5 4 20 

2 Section - B 

(Essay 

Questions) 

10 10 100 5 10 50 

Total Marks 

 

150 Total Marks 70 

 

 

 

 

 

 

 

 



 

 

 

Department of Commerce 

      I B. Com HONOURS GENERAL 

SEMESTER –I: COMMERCE PAPER – I 

                                                BUSINESS ORGANIZATION AND MANAGEMENT                                                                           

                                                   Code: 25BCG102T 

BLUE PRINT FOR THE QUESTION PAPER SETTING 

 

Chapter Name   
 

Short questions 

5 marks   

Essay questions  10 

marks  

 

UNIT – I 2 2 

UNIT – II 2 2 

UNIT – III 2 2 

UNIT – IV 2 2 

UNIT – V 2 2 

Total No. of Questions  

 

10 10 

 

             Signature of the Chairman                                             Signature of the BOS Members 

        

 

                                         

 

 

 



 

 

 

Department of Commerce 

I B. Com HONOURS IN COMPUTER APPLICATION 

SEMESTER –I : COMMERCE PAPER – I 
BUSINESS ORGANIZATION AND MANAGEMENT 

    Time : 3 hrs                                         CODE: 25BCG102T               Max Marks : 70 

 ________________________________________________________________________ 
MODEL QUESTION PAPER 

Answer any Five of the following Questions     5X4 =20 Marks 

1.Define business and explain its characteristics. 

2.Distinguish between sole proprietorship and partnership. 

3.What is a One Person Company (OPC)? Explain its features. 

4.Define Join stock company. 

 5.Define Corporate Social Responsibility (CSR)  

6.Explain the concept of Total Quality Management (TQM). 

7.Differentiate between delegation and decentralization. 

8.Explain Maslow’s hierarchy of needs theory. 

9.Different methods of controlling. 

10.Explain Budgetary control. 

 

SECTION -B 

Answer one question from each unit.                                                     5 × 10 = 50 Marks 

                                                                      Unit I 

Q11. Explain the different forms of business organization. 

                                                                        OR 

Q12. Explain the merits and demerits of sole proprietorship. 

                                                                    Unit II 

Q13. Discuss mergers and acquisitions and their impact on business. 



 

 

OR 

Q14.What is total Quality Management (TQM)? Explain the advantages and disadvantages of TQM? 

                                                                    Unit III 

Q15. Explain the functions of management and the role of SWOT analysis in planning. 

OR 

Q16. Explain the differences between Delegation and Decentralization 

                                                                    Unit IV 

Q17. Explain Theory X and Theory Y and their relevance in employee motivation. 

OR 

Q18. Discuss the different leadership styles  

                                                                    Unit V 

Q19. Explain line and staff relationship and the importance of control in management. 

OR 

Q20. Discuss the process and techniques of control, including budgetary control. 

 

Signature of the Chairman                      Signature of the BOS Members  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

DEPARTMENT OF COMMERCE 

Common to All Groups – Semester I 

Skill paper 

 
Course Code Title of the Course L S/M P C 

25BCS101S AI Fundamentals    4  4 

Prerequisites Basics of Computers 

 

COURSE OBJECTIVES 

1 
Understand the history and evolution of Artificial Intelligence and Identify major subfields of 
AI. 

2 Investigate the role of AI in various industries like healthcare, agriculture, and education.  

3 Examine concepts like bias, fairness, transparency, and accountability in AI systems. 

4 
Explore the integration of AI in scientific research and discuss future directions and evolving 
trends in AI. 

5 Learn how prompt engineering is used in various sectors like education and content creation. 
 

 

COURSE OUTCOMES 
BTL 

Upon successful completion of the course, the student will be able to: 

CO1 Describe the different subfields and their roles in AI applications. Understanding 

CO2 
Summarize the benefits and limitations of AI in diverse domains. 
 

Understanding 

CO3 Operate AI systems in terms of inclusivity, privacy, and robustness. Applying 

CO4 Practice Generative AI and emerging technologies like ChatGPT. Applying 

CO5 Apply prompt engineering concepts to various real-world use cases. Applying 

 
 
 
 



 

 

SEMESTER –I:  SKILLPAPER  
DEPARTMENT OF COMMERCE 

ARTIFICIAL INTELIGENCE FUNDAMENTALS  

Syllabus 

 

COURSE CONTENT 

UNIT I 

Introduction to Artificial Intelligence: History, Definition, Artificial General 

Intelligence, Challenges in AI. Knowledge Engineering, Machine Learning, Computer 

Vision, Natural Language Processing, Robotics. 

UNIT II Applications of AI: Healthcare, Finance, Retail, Agriculture, Education, Transportation. 

UNIT III 

Bias and Fairness in AI Systems: Ethics in AI, Bias and Fairness in AI Systems, Transparency 

in AI Systems, Accountability, Security, Privacy, Inclusivity, Sustainability, Robustness, 

Reliability. 

UNIT IV 

AI in Research, Generative AI and prompt engineering: AI in Experimentation and 

Multi-disciplinary research, Generative AI introduction, ChatGPT, Hugging Face, 

Gemini, Copilot, Perplexity. 

UNIT V 

Prompt engineering: Prompt engineering Definition and its importance, Role of Prompt 

Engineering in AI/ML Interaction. 

Applications of Prompt Engineering: Education, Business & Commerce,  

Content Creation: AI for Creative Writing, AI for creative design, writing AI scripts for 

video, generating slides and slidesGPT usage. 

 

TEXT BOOKS 

1. 
AI for Everyone: A Beginner's Handbook for Artificial Intelligence (AI) by Saptarsi Goswami, Amit 

Kumar Das, Amlan Chakrabarti 

2. Prompt Engineering for Beginners: by Kapila Arora, Geetu Garg, Gaurav Arora. 

 



 

 

REFERENCE BOOKS 

1. Let’s Learn Artificial Intelligence: Base Module, Niti Ayog, Atal Innovation Mission.  

2. 
Prompt Engineering for Generative AI: Future-proof inputs for Reliable AI-outputs by James 
Phoenix & Mike Taylor. 

3. 
Generative AI 360°: Practical Guide to ChatGPT, Midjourney & AI Tools to Boost Productivity 
&Creativity, For Professionals, Marketers & Entrepreneurs by Hitesh Motwani,Zebra Learn, 2025. 

WEB RESOURCES 

1. 
Learn Generative AI Prompt Engineering for everyone. https://www.coursera.org/learn/generative-ai-
prompt-engineering-for-everyone?action=enroll 
 

2. 
Generative AI Tutorial:https://www.w3schools.com/gen_ai/ 
 

3. 

Free Artificial Intelligence (AI) Tutorial - Hands-On Prompt Engineering for AI Beginners & Business User | 
Udemy, https://www.udemy.com/course/prompt-engineering-for-ai-beginners-business-users 

 
 
 

CO-POMapping: 

 

  PO1 PO2 PO3 PO4 PO5 PO6 PO7 PO8 PO9 PO10 PSO1 PSO2 PSO3 PSO4 

CO1 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO2 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO3 1 1 1 3 2 2 2 1 2 2 3 1 3 0 

CO4 2 2 1 3 3 2 2 1 3 2 3 1 3 1 

CO5 2 2 1 3 2 2 2 1 2 2 3 1 3 1 

 

 

 

 

 

 

 

 

 

https://www.coursera.org/learn/generative-ai-prompt-engineering-for-everyone?action=enroll
https://www.coursera.org/learn/generative-ai-prompt-engineering-for-everyone?action=enroll
https://www.w3schools.com/gen_ai/
https://www.udemy.com/course/prompt-engineering-for-ai-beginners-business-users


 

 

 

DEPARTMENT OF COMMERCE 

SEMESTER –I:  SKILLPAPER  
ARTIFICIAL INTELIGENCE FUNDAMENTALS  

Model Blueprint for the question paper setter 

 

Sl. No. UNIT- Essay 10M Weightage 

1 I 2 20% 

2 II 2 20% 

3 III 2 20% 

4 IV 2 20% 

5 V 2 20% 

  100 100% 
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AI Fundamentals- Common to all Groups 

Semester-I 
Recommended Format of Question Paper for all Courses 

                             Time: 3 Hours                                                                                        Max. Marks: 70 

Section-A 

       Answer any FIVE of the following questions.    (5X4 = 20Marks) 

1. From Contents of Unit-I 

2. From Contents of Unit-I 

3. From Contents of Unit -II 

4. From Contents of Unit -II 

5. From Contents of Unit -III 

6. From Contents of Unit -III 

7. From Contents of Unit -IV 

8. From Contents of Unit -IV 

9. From Contents of Unit -V 

10. From Contents of Unit -V 

Section-B  

Answer FIVE questions.        (5X10=50Marks) 

A) From Contents of Unit-I 
OR 
B) From Contents of Unit-I 
A) From Contents of Unit-II 
 OR 
B) From Contents of Unit -II 
A) From Contents of Unit -III 
OR 
B) From Contents of Unit -III 
A) From Contents of Unit -IV 
OR 
B) From Contents of Unit -IV 
A) From Contents of Unit -V 
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OR 
B) From Contents of Unit –V 

 

AI FUNDAMENTALS 
MODEL QUESTION PAPER (W.E.F 2025-2026)  

Common to All Groups 

Time: 3 Hrs.                                                                                             Marks:70 Marks 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

Q. No Question Marks BL CO PO PI 

SECTION – A 

Answer any Five of the Following 5 X 4 = 20M  

1 Explain about Machine Learning. 4M 2 1   

2 Discuss about Robotics. 4M     2 1   

3 Illustrate the AI applications in Finance sector 4M 2 2   

4 Explain how AI can be applied in transportation. 4M 2 2   

5 What is ethics in AI? 4M 1 3   

6 Discuss about Accountability and Security in AI 
Systems. 

4M 2 3   

7 How is Copilot used? 4M 2 4   

8 What is Hugging face? 4M 1 4   

9 Define prompt engineering. 4M 1 5   

10 What are the applications of Prompt engineering in 
Education? 

4M 1 5   
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Common to All Groups – Semester I 

CourseCode TitleoftheCourse L T P C 

25BCS101L AI FUNDAMENTALS   2 0 

Prerequisites Basic Computer Knowledge 

 

Practice Session 

 

1.Create a mind map of AI subfields: NLP, CV, ML, Robotics, Knowledge Engineering using Canva/Napkin AI/ 

Similar Open AI tool  

2. Text Analysis with Open-Source NLP Tools: Tool: Voyant Tools (text analysis web app)  

● Input sample texts (e.g., news articles, speeches).  

● Explore word frequency, keywords, sentiment.  

● Understand how NLP extracts meaning from text.  

3. Train a basic image classifier using webcam images. Observe how the model "learns." Using Google 

Teachable Machine  

● Train two image categories (e.g., “Smiling” vs. “Not Smiling”) using their own webcam images.  

● Observe how the model learns to classify.  

● Now try feeding images of people with different skin tones, facial features, etc.  

● Observe misclassifications or differences in confidence.  

4. Simulate an AI chatbot helping a farmer or a student. You may use any GenAI tool of your choice. You may 

use the prompt below and also try your own.  

Prompt:  

“Act as an agriculture assistant. A farmer wants to know the best crop based on soil and season. Ask questions 

and suggest crops.”  
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5. Test Generative AI- Generate a poem or image from prompt “A futuristic green city.” using ChatGPT, 

Hugging Face (e.g., image or text generation)  

6. Observe how generative AI models may show biased results when prompted with neutral profession 

descriptions. (Bing Image Creator / DALL·E on ChatGPT/ChatGPT). Generate images using the following neutral 

prompts:  

● “A doctor treating a patient”  

● “A teacher in a classroom”  

● “A CEO giving a speech”  

● “A software engineer working from home” Observe and discuss:  

● What gender/race/age are most commonly shown? ● Are the results stereotypical or diverse?  

7. Check how language models may express bias depending on names, ethnicity, or location.  

Use Chat GPT or Gemini  

Prompts:  

Prompt A:  

“A person named Raj is applying for a bank loan. Will he be approved?”  

Prompt B: 

“A person named John is applying for a bank loan. Will he be approved?”  

Change names, genders, and nationalities.  

Observe the following and report your findings:  

● Are the responses different?  

● Is one version more positive or negative?  

● Does the model express bias or hesitate?  

● Should AI make such predictions?  

● How do developers prevent this?  

8. Exploring Text Generation and Summarization with Google AI Studio  
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Generate Creative Content  

“Write a short story (150 words) about a robot who wants to become a chef.”  

● Submit and read the AI-generated story.  

● Discuss how detailed and creative the output is.  

Summarize a Paragraph  

Prompt:  

Summarize the following paragraph in 3 sentences:  

“Artificial Intelligence is a branch of computer science that aims to create intelligent machines that can mimic 

human thinking. It includes various subfields like machine learning, natural language processing, and robotics. 

AI is widely used in industries such as healthcare, finance, and transportation to improve efficiency and 

decision-making.”  

● Submit and review the summary.  

● Evaluate how well AI extracts key points.  

Refine Your Prompt  

Try changing the summary prompt to:  

“Summarize the paragraph above in simple language for 10-year-olds.”  

● Compare this output to the previous one. 

● Note how prompt wording changes results.  

9. AI for Creative Writing  

Prompt:  

“Write a short motivational story for 10-year-old students in under 150 words.”  

10. Generate Slides: Tool: Slides GPT/ Another Free AI tool  

Prompt:  

“Create a 5-slide presentation on ‘AI in Smart Farming’.”  

11. YouTube Thumbnails / Branding: Tool: Canva + Magic Media AI  

Design a thumbnail using Canva’s AI tools with a prompt like:  

“Design a YouTube thumbnail for a video titled ‘Top 5 AI Tools for Students’.” 
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DEPARTMENT OF COMMERCE 

SEMESTER –II : COMMERCE PAPER – II 

I B.Com (GENERAL) 

FINANCIAL ACCOUNTING - II 

                 COURSE STRUCTURE 

 

 

l. No Course Codes Course Internal External Max.Marks  Credits 

1 25BCG203T Financial Accounting - II 30 70 100 4 

2 25BCG204T Business Economics 30 70 100 4 
 

3 25 BCG202S 
25BCG202L 

Artificial Intelligence 30 70 100 4 
 

 

Signature of the BoS Chairman    Signature of the BOS Members 
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                                                         DEPARTMENT OF COMMERCE 

I B. Com HONOURS GENERAL 

    SEMESTER – II : COMMERCE PAPER – III 

FINANCIAL ACCOUNTING - II 

 

        

                                                                                   25BCG203T  

Course Objectives  

This course is designed to enable students to achieve the following objectives: 

 Understand consignment accounts. 

 Evaluate different methods of joint ventures accounting. 

 Familiarize with the preparation of accounts in non-profit organizations. 

 Acquaint with preparation of partnership deed and treatment of various accounts. 

 Give practical insights on partnership accounts which; admission, retirement, death     

and dissolution. 

Course Outcomes (COs): 

Upon successful completion of this course, students will be able to : 

CO1: Analyze the various accounts related to consignment business.  

CO2: Prepare accounts of joint ventures under different methods. 

CO3: Understand the preparation of receipts and payment, income and expenditure accounts.  

CO4: To explore the essence of partnership deed and preparation of accounts in partnership.  

CO5: Apply accounting procedures for partner’s death, firm dissolution, and insolvency          

         including the Garner v. Murray Rule. 
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DEPARTMENT OF COMMERCE 

I B. Com HONOURS GENERAL 

SEMESTER – II : COMMERCE PAPER – I 

FINANCIAL ACCOUNTING - II 

 

 

 

      Credits : 04                    Teaching Hrs/Week:5 Theory 

 

SYLLABUS 

 

Unit I: Bills of Exchange 

Meaning of Bill – Features of Bill –– Discounting of Bill –  Renewal of Bill – Dis honour of the Bill - 

Entries in the Books of Drawer and Drawee (Including Problems). 

Unit-II : Consignment Accounts 

Consignment - Features - Proforma Invoice - Account Sales – Del-credere Commission - Accounting 

Treatment in the Books of Consigner and Consignee - Valuation of Closing Stock - (including Problems). 

Unit-III: Joint Venture Accounts 

Joint Venture - Features - Difference between Joint-Venture and Consignment – Accounting Procedure – 

Methods of Keeping  Records–One Vendor Keeps the Accounts and Separate Set off Books Methods 

(including Problems). 

Unit IV: Partnership Accounts-I 

Meaning–Partnership Deed-Fixed and Fluctuating Capitals Accounting - Treatment of Goodwill – 

Admission (including problems). 

 

Unit V: Partnership Accounts-II: 

Retirement - Death of a Partner - Dissolution of a Partnership Firm – Application of Garner v/s Murray 

Rule in India – Insolvency of Partners  - (simple problems) 

Activities: 

- Visit a local consignment agency to collect and analyze real samples of proforma invoices and account 

     25BCG203T 
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sales statements. 

- Prepare a comparative chart highlighting key differences between consignment and joint venture 

transactions, roles, and accounting procedures. 

- Draft Receipts &Payments Account and Income &Expenditure Account using simulated or real data from 

a non-profit organization. 

- Conductinterviewsorfieldinteractionwithofficebearersofalocalnon-profit organization to understand their 

accounting practices and compliance with Sec 8. 

- Group activity to draft a model partnership deed, including clauses on profit sharing, admission, 

retirement, and treatment of goodwill. 

References: 

1. Ranganatham,G.,& Venkata Ramanaiah,M.(2019).Financialaccounting.NewDelhi:S.  Chand 

Publications. 

2. Gupta,R.L.,&Gupta,V.K.(2022).Principlesandpracticeofaccounting(18thed.). New Delhi: Sultan 

Chand & Sons. 

3. Reddy,T.S.,&Murthy,A.(2022).Financialaccounting(Reviseded.).Chennai: Margham Publications. 

4. Jain, S. P., &Narang, K. L. (2023). Advanced accountancy – Vol. I (Latest ed.). Ludhiana: Kalyani 

Publishers. 

5. Maheshwari, S. N., &Maheshwari, S. K. (2021). Introduction to accountancy (12th ed.).New Delhi: 

Vikas Publishing House. 
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DEPARTMENT OF COMMERCE 

I B. Com HONOURS (GENERAL) 

SEMESTER –II: COMMERCE PAPER – III 

FINANCIAL ACCOUNTING - II 

   

BLUE PRINT FOR THE MODEL PAPER 

 

 

S.N O  
 

 

Type of 

Question  
 

 

To be given in the Question Paper  
 

 

To be answered 
 

No. of 

Questions 
 

Marks 

allotted to 

each 

question 
 

Total 

Marks  
 

No. of 

Questions  
 

Marks 

allotted 

to each 

question  
 

Total 

Marks  
 

1 

 

Section - A 

(Short 

Questions) 

10 5 50 5 4 20 

2 Section - B 

(Essay 

Questions) 

10 10 100 5 10 50 

Total Marks 

 

150 Total Marks 70 

 

       

 

 

 

 

 

 

 

 

25BCG203T 
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                                                           DEPARTMENT OF COMMERCE 

I B. Com HONOURS (GENERAL) 

  SEMESTER –II: COMMERCE PAPER – III 

FINANCIAL ACCOUNTING - II 

                                               

                                                                        Code: 25BCG203T 

 

BLUE PRINT FOR THE QUESTION PAPER SETTING 

 

Chapter Name   
 

Short questions 

5 marks   

Essay questions  10 

marks  

 

UNIT – I 2 2 

UNIT – II 2 2 

UNIT – III 2 2 

UNIT – IV 2 2 

UNIT – V 2 2 

Total No. of Questions  

 

10 10 

 

                 Signature of the Chairman    Signature of the BOS Members 
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DEPARTMENT OF COMMERCE 

I B. Com HONOURS GENERAL SEMESTER –I: COMMERCE PAPER – III 

FINANCIAL ACCOUNTING – II 

 

            Time : 3  hrs                            CODE: 25BCG203T                         Max Marks : 70   

___________________________________________________________________________ 

MODEL QUESTION PAPER 

       Answer any Five of the following Questions     5X4 =20 Marks 

1.Define a Bill of Exchange. 

2.What is a Consignment  

3.Explain the main features of a Joint Venture. 

     4.Distinguish between Fixed Capital and Fluctuating Capital. 

5.What is Goodwill  

6. Proforma Invoice. 

7.What is Del-Credere Commission 

8.Explain the difference between Joint Venture and Partnership. 

9. Dishonour of a Bill. 

     10.Explain the rule of Garner v/s Murray. 

SECTION – B 

 Answer ONE question from each unit .            (5 × 10 = 50 Marks) 

UNIT – I 

Q11. Explain the feature of Bill 

OR 
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Q12. On 1st March 2025, A sold goods to B for Rs.25,000 and drew a bill for 3 months for the same amount. B 

accepted the bill and returned it to A. A discounted the bill with his bank at 6% p.a. On the due date, the bill 

was dishonoured, and the bank paid Rs.100 as noting charges. 

Pass the journal entries in the books of both A and B. 

UNIT – II 

Q13.Accounting Treatment in the books of consignee and consigner 

OR 

Q14 

Ram of Chennai sent goods costing ₹40,000 on consignment to Shyam of Delhi. Ram paid Rs.2,000 for freight 

and insurance. Shyam spent Rs.1,000 for unloading and Rs.500 for godown rent. Shyam sold 75% of the goods 

for Rs.45,000 and is entitled to 5% commission on sales and an additional 2% Del-Credere Commission. Bad 

debts amounted to Rs.500. 

 

Prepare Consignment Account and Shyam’s Account in the books of Ram. 

UNIT – III 

Q15. What is a Joint Venture? Explain the methods of maintaining Joint Venture Accounts. 

OR 

Q16.  

A and B entered into a Joint Venture to construct a shed for Rs.50,000. A contributed Rs.30,000 and B 

Rs.20,000. A made payments of Rs.28,000 for materials and expenses; B paid Rs.17,000. The contract was 

completed and payment received Rs.55,000. Prepare Joint Venture Account and Co-Venturers 

 Accounts in the books of A, when A keeps all the books. 

 

UNIT – IV 

Q17.Explain the accounting treatment of Good will at the time of admission of a new partner. 

OR 

Q18.  

A and B are partners sharing profits in the ratio of 3 : 2. Their capitals are Rs.40,000 and Rs.30,000 respectively. 

C is admitted as a new partner for 1/4th share of profits. He brings Rs.20,000 as capital and Rs.10,000 as 

goodwill in cash. 

Pass necessary Journal Entries and prepare the Partners’ Capital Accounts. 
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UNIT – V 

Q19.  

Explain the procedure for settling the accounts of partners after dissolution of a firm. 

OR 

Q20. 

A, B and C are partners sharing profits in the ratio of 3 : 2 : 1. Their Balance Sheet on the date of dissolution 

shows: 

Liabilities Rs. Assets Rs. 

Creditors 12,000 Cash 2,000 

A’s Loan 6,000 Debtors 18,000 

Capitals: A – 20,000 B – 10,000 C – 

4,000 
34,000 Stock 15,000 

  
Furniture 17,000 

Total 52,000 Total 52,000 

The assets realized as follows: Debtors Rs.16,000, Stock Rs.12,000, Furniture Rs.15,000. Creditors were paid in 

full, realization expenses Rs.1,000. 

Show Realisation Account, Partners’ Capital Accounts, and Cash Account. 

 

Signature of the BoS Chairman                                Signature of the BOS Members 
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DEPARTMENT OF COMMERCE 
I B. Com HONOURS GENERAL 

SEMESTER – II : COMMERCE PAPER – IV 
BUSINESS ECONOMICS 

                 Theory:4                                    Credits: 4hrs/week  

Course Objectives: 

         This course is designed to enable students to achieve the following objectives: to 

- Understand and explain the meaning, nature, and scope of Business Economics along with the 

interface between Micro and Macro Economics. 

- Analyze consumer demand, its determinants, and apply the law of demand and elasticity concepts in 

real-world scenarios. 

- Evaluateproductionprocesses,coststructures,andapplybreak-evenanalysisfor effective business 

decision-making. 

- Identifyanddifferentiatebetweenvariousmarketstructuresandassesspricingandcompetition strategies in 

each. 

- Interpret the components and measurement methods of national income and understand challenges in 

economic data analysis. 
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                                                          DEPARTMENT OF COMMERCE 

I B.Com HONOURS GENERAL 

SEMESTER – II : COMMERCE PAPER – IV 
COURSE : BUSINESS ECONOMICS 

 

Name of the Programme  : B.Com 

Name of the Specific Programme : GENERAL (Honors) 

Semester    : II 

Name of the Course (Paper)  : Business Economics 

Paper Code    : 25BCG204T 

Course Outcomes   : At the end of the course students able to 

 

CO1  To Understand the nature and scope of business economics and distinguish between 

micro and macroeconomics.  

CO2 
To Analyse demand, elasticity, and consumer behaviour for business decision-making.  

CO3 
To Apply production and cost concepts, including break-even analysis, to assess 

viability. 

CO4 
To Differentiate market structures and explain price-output determination under 

perfect competition.& Understand national income concepts and evaluate the impact 

of structural reforms and macro indicators 

       Signature of the Internal BOS Members 

1. 

2. 

3. 

4. 
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                                                          DEPARTMENT OF COMMERCE 

I B. Com HONOURS GENERAL 

 SEMESTER – II : COMMERCE PAPER – IV 

BUSINESS ECONOMICS 

      Credits : 04          Teaching Hrs/Week : 4 

SYLLABUS  

Unit-I: Introduction  

Meaning and Definitions of Business Economics - Nature and Scope of Business Economics - Micro and Macro 

Economics - differences and their Interface. 

 

UNIT-II: Demand Analysis  

Meaning and Definition of Demand - Determinants of Demand - Demand Function- Law of Demand - 

Exceptions to Law of Demand- Elasticity of Demand -Measurement of Price Elasticity of Demand. 

 

UNIT – III: Production, Cost and Revenue Analysis  

Concept of Production Function – COBB - Douglas - Production function - Law of Variable Proportions - Law 

of Returns to Scale Classification of Costs – Short run Vs Long run cost-Average cost- marginal cost- Break - 

Even Analysis.  

UNIT-IV: Market Structure  

Concept of Market – Classification of Markets - Characteristics of Perfect Competition & Imperfect 

Competition – Monopoly- Price determination- Price discrimination. 

 

UNIT-V: National Income  

Meaning – Definition - Concepts of National Income – GDP - Measurement of National Income Components of 

National Income - Challenges in measuring National Income.  
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References:  

1 Aryasri and Murthy-Business Economics -Tata Mc Graw Hill. 

2 H.L Ahuja -Business Economics -Sultan Chand &Sons. 

3 S. Sankaran -Business Economics -Margham Publications. 

4 P.C. Chopra -Business Economics –Kalyani Publications. 

5 Deepa Sree -Business Economics -Himalaya Publishing House 

 

CO:PO: MAPPING: 

 

    [‘1’: Slight (Low); ‘2’: Moderate (Medium); ‘3’: Substantial [High], '-’:(No Correlation)] 

 

 PO1 PO2 PO3 PO4 PO5 PO6 PO7 PO8 PSO1 PSO2 PSO3 

CO1 2 1 2 2 1 - 2 3 3 1 3 

CO2 3 1 2 2 - 1 2 3 3 2 3 

CO3 3 1 3 1 - 1 2 3 3 2 3 

CO4 3 2 2 2 1 1 1 2 2 2 2 

Avg. 2.75 1.25 2.25 1.75 0.5 0.75 1.75 2.75 2.75 1.75 2.5 
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DEPARTMENT OF COMMERCE 

 

I B. Com HONOURS (GENERAL) 
SEMESTER –II: COMMERCE PAPER – IV 

BUSINESS ECONOMICS 
  

 

BLUE PRINT FOR THE MODEL PAPER 

 

 

S. 

NO  
 

 

Type of 

Question  
 

 

To be given in the Question Paper  
 

 

To be answered 
 

No. of 

Questions 
 

Marks 

allotted to 

each 

question 
 

Total 

Marks  
 

No. of 

Questions  
 

Marks 

allotted 

to each 

question  
 

Total 

Marks  
 

1 

 

Section - A 

(Short 

Questions) 

10 5 50 5 4 20 

2 Section - B 

(Essay 

Questions) 

10 10 100 5 10 50 

Total Marks 

 

140 Total Marks 70 

 

 

 

 

 

25BCG204T 
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                                                          DEPARTMENT OF COMMERCE 

I B. Com HONOURS (GENERAL) 

SEMESTER –II: COMMERCE PAPER – IV 

BUSINESS ECONOMICS                                                                                                                                       

Code: 25BCG204T 

BLUE PRINT FOR THE QUESTION PAPER SETTING 

 

Chapter Name   
 

Short questions 

5 marks   

Essay questions  10 

marks  
 

UNIT – I 2 2 

UNIT – II 2 2 

UNIT – III 2 2 

UNIT – IV 2 2 

UNIT – V 2 2 

Total No. of Questions  

 

10 10 

 

 

          Signature of the Members                 Signature of the BOS Chairman 
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DEPARTMENT OF COMMERCE 
I B. Com HONOURS GENERAL SEMESTER –I: COMMERCE PAPER – IV 

BUSINESS ECONOMICS 
 

         Time : 3  hrs                                 CODE: 25BCG204T                   Max Marks : 70M   

___________________________________________________________________________ 

 

 

I. Answer any Five from the following Questions.           ( 5*4 = 20M) 

1. Define Business Economics and explain its scope. 

2. What do you mean by the Circular Flow of Economic Activity? 

3. Distinguish between Microeconomics and Macroeconomics. 

4. What are the main determinants of demand? 

5. State the Law of Demand and explain its exceptions. 

6. Define Elasticity of Demand. What are its types? 

7. Explain the concept of Marginal and Average Cost. 

8. What are the characteristics of Perfect Competition? 

9. Define National Income and explain its importance. 

10. Write a short note on Balance of Payments 

PART – B 

II. Answer one question from each unit of the following Questions (internal choice). 5 x 10 = 50M 

Unit - I 

11. Define Business Economics. Discuss its nature, scope, and importance. 

Or  

12 Explain the objectives of firms and discuss the nature of economic laws and methods of economic enquiry. 
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Unit - II 

13. What is demand? Explain the Law of Demand and the factors determining demand for a commodity. 

OR 

14. Discuss Elasticity of Demand and explain the concept of Consumer’s Surplus. Also describe the Law of 

Returns. 

Unit - III 

15. Explain the different cost concepts and show the relationship between marginal cost and average cost with 
diagrams. 
OR 

16.Discuss the different types of market structures – Perfect Competition, Monopoly, Monopolistic 

Competition, Duopoly, and Oligopoly. 

Unit – IV 

17. Define National Income. Explain the different methods of measuring national income. 

OR 

18. Write short notes on: 

a) Phases of Business Cycles 

b) Strategies and policies to overcome business cycles. 

Unit – V 

19. Explain the impact of globalisation on the Indian economy and discuss the theory of international trade. 

OR 

20. Write notes on: 

a) Balance of Trade and Balance of Payments 

b) Foreign Exchange Markets and factors influencing exchange rates. 
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Applicable To Commerce and Management– Semester II 

 
Course Code Title of the Course L S/M P C 

25BCG202S 
25BCC202S 
25BBA202S 
25BFS202S 

 

Applications of Artificial Intelligence 

  

3 

  
3 

Prerequisites Basics of Artificial Intelligence 

 

COURSE OBJECTIVES 

1 
Provide a foundation in the AI ecosystem, including hardware, cloud, and edge platforms 
relevant to commerce and management. 

2 
Familiarize students with different types of datasets and public repositories used in AI 
research. 

3 
Develop skills in building AI data pipelines through collection, annotation, cleaning, and pre 
processing. 

4 
Understand how AI enhances retail and e-commerce and explore personalization, 
recommendation systems, and customer engagement. 

5 
Apply AI to streamline business processes and decision-making and explore AI in finance, HR, 
and supply chain management. 

 

 

COURSE OUTCOMES 
BTL 

Upon successful completion of the course, the student will be able to: 

CO1 
Explain the AI ecosystem (hardware, cloud, and edge devices) and its 
relevance to commerce and management. 

Understanding 

CO2 
Differentiate between structured and unstructured data, and utilize 
public datasets for business-oriented AI applications. 

Understanding 

CO3 
Implement a conceptual AI data pipeline for solving real-world 
problems in commerce and management. 

Applying 

CO4 
Understand and apply AI technologies to improve customer 
engagement and personalization in commerce. 

Understanding 

CO5 
Use AI tools to streamline business operations, enhance decision-
making, and detect patterns in data. 

Applying 
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Applicable To Commerce and Management– Semester II 

Syllabus 

 

COURSE CONTENT 

UNIT I 

Infrastructure and Platforms for Building Applications using AI: 

 

Hardware used in building AI applications: Processors - CPU, GPU, TPU, NPU, 

Memory - RAM, VRAM, Storage - HDD, SSD  

Platforms for building applications using AI: Online platforms (Example - Google 

AutoML, H2O.ai; Desktop (No-code/Low code) platforms (Orange Data Mining, 

KNIME.  

Edge AI: Concept; Applications in daily life in devices like Refrigerators, Led Bulbs, 

Surveillance Cameras, Micro Ovens, Smart Cars/Scooters; Edge AI in smart Appliances. 

UNIT II 

Foundations of Data - Types, Ethics and Utility in Building Applications using AI: 

 

Importance of data in building AI applications: Data as the fuel for AI, Role of big 

data in training AI models.  

Conceptual Foundations of Data: Data vs. Information vs. Knowledge.  

Structure of Data: Structured, Semi-Structured, and Unstructured Data.  

Modalities of Data: Text, Image, Audio, Video, Tabular. 

Formats of Data: Text Formats (CSV, JSON, XML), Image Formats (JPEG, GIF, 

PNG), Audio/Video (MP3, WAV, MP4, AVI).  

Data Repositories: Definition of public Datasets; Definition of private Datasets; 

Importance of Public Datasets, Popular Public Dataset Repositories (Example - Kaggle, 

Google Dataset Search or similar ones - for demonstration only), Dataset licensing and 

usage rights.  

Ethics, Privacy in Data Usage: Privacy concerns related to data usage; Ethical use of 

data, Responsible AI data practices. 

UNIT III 

The AI Data Pipeline: From Collection to Model Readiness: 

The AI Data Pipeline: Stages and Components: Key Stages (Data Collection, Annotation, 

Preprocessing, Splitting, Feeding into AI Models  
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Core Components: Ingestion, Storage, Processing, Validation, Delivery  

Data Collection Methods for AI: Manual Input (Surveys, forms, human-curated entries), 

Sensors & IoT Devices (Real-time data from physical environments), System Logs & 

Transactions, Web Scraping (Automated extraction from websites), APIs (Structured data 

access from external platforms)  

Data Annotation and Labelling: Definition & Importance; Annotation Methods: Manual 

Annotation, Automated Annotation;  

Data Cleaning and Preprocessing: Importance of data cleaning; Understanding “Dirty” Data: 

Missing Values, Duplicates, Incorrect Formats, Outliers, Noise; Steps in Data Cleaning: 

Identify Issues, Handle Errors (Imputation, Removal), Validate Cleaned Data.  

Data Splitting: Splitting data into training set and test set.  

Data Transformation Techniques: Normalization, Transformation. 

UNIT IV 

AI in Commerce – Transforming the Consumer Experience  

 

Introduction to AI in Commerce, Recommendation Engines (Collaborative & Content-

Based), Chatbots and Virtual Assistants, Sentiment Analysis and Review Mining, 

Inventory Optimization and Demand Forecasting, Ethical Issues related to use of AI in 

Commerce and Business: Bias, Privacy, and Transparency. 

UNIT V 

AI in Business Operations – Driving Efficiency and Insight: 

AI in Business Intelligence and Predictive Analytics, Financial Applications: Fraud 

Detection, Risk Modelling, HR Applications: Resume Screening, Employee Analytics, 

Supply Chain Automation and Optimization, AI in Marketing: Customer Segmentation, Lead 

Scoring, Strategic Adoption of AI in Enterprises, Explainable AI in E-Commerce. 

 

TEXT BOOKS 

1. 
Data Science for Beginners, Andrew Park (Introductory concepts of data types, collection, 
cleaning, and visualization without coding) 

2. 
AI Basics for Non-Programmers, Tom Taulli (Clear explanations of AI data lifecycle and real-world 
use cases). 

REFERENCE BOOKS 

1. 
Data Preparation for Machine Learning, Jason Brownlee (Conceptual understanding of dataset 
quality, preprocessing, and pipelines). 

2. 
Hands-On Data Science for Non-Programmers, David Meerman Scott  
(Spreadsheet-based data exploration and visualization). 

3. You Look Like a Thing and I Love You – Janelle Shane 
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WEB RESOURCES 

1. Kaggle Dataset Search, https://www.kaggle.com/datasets 

2. Google Dataset Search, https://datasetsearch.research.google.com 

3. UCI Machine Learning Repository, https://archive.ics.uci.edu 

4. Hugging Face Datasets, https://huggingface.co/datasets 

5. Open Government Data (India), https://data.gov.in 

 

 

     CO-PO Mapping:  

 

  PO1 PO2 PO3 PO4 PO5 PO6 PO7 PO8 PO9 PO10 PSO1 PSO2 PSO3 PSO4 

CO1 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO2 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO3 1 1 1 3 2 2 2 1 2 2 3 1 3 0 

CO4 2 2 1 3 3 2 2 1 3 2 3 1 3 1 

CO5 2 2 1 3 2 2 2 1 2 2 3 1 3 1 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.kaggle.com/datasets
https://datasetsearch.research.google.com/
https://archive.ics.uci.edu/
https://huggingface.co/datasets
https://data.gov.in/
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Applicable To Commerce and Management– Semester II 

Model Blue print for the question paper setter 

 

Sl. No. UNIT- Essay 10M Weightage 

1 I 2 20% 

2 II 2 20% 

3 III 2 20% 

4 IV 2 20% 

5 V 2 20% 

  100 100% 
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Applicable To Commerce and Management- 

Semester-II 

Recommended Format of Question Paper  

Time: 2½Hrs           Max. Marks: 70 

Section-A 

Answer any FIVE of the following questions.        5X4=20 

1. From Contents of Unit-I 

2. From Contents of Unit-I 

3. From Contents of Unit -II 

4. From Contents of Unit -II 

5. From Contents of Unit -III 

6. From Contents of Unit -III 

7. From Contents of Unit -IV 

8. From Contents of Unit -IV 

9. From Contents of Unit -V 

10. From Contents of Unit -V 

Section-B 

Answer FIVE questions.        5X10=50 

A) From Contents of Unit-I 
OR 
B) From Contents of Unit-I 
A) From Contents of Unit-II 
 OR 
B) From Contents of Unit -II 
A) From Contents of Unit -III 
OR 
B) From Contents of Unit -III 
A) From Contents of Unit -IV 
OR 
B) From Contents of Unit -IV 
A) From Contents of Unit -V 
OR 
B) From Contents of Unit –V 
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                                                                         Applications of AI  
Applicable to Commerce and Management 
MODEL QUESTION PAPER (W.E.F2025-2026) 

Time: 2½Hrs. Max Marks : 50 

Q. No Question Marks BL CO PO PI 

SECTION – A 

Answer any Five of the Following 5 X 4 = 20M  

1  Explain about any online platform to build AI application. 4M 2 1   

2 State about the Edge AI in smart Appliances. 4M 1 1   

3 Write a short note on “Structure of Data”. 4M 1 2   

4 Explain about Modalities of Data. 4M 2 2   

5 Define the process of Data Annotation and Labeling. 4M 2 3   

6 Discuss about various data collection methods for AI. 4M 2 3   

7 Write short note on Sentiment Analysis and Review Mining. 4M 1 4   

8 Discuss about the role of AI in Inventory Optimization and 
Demand Forecasting. 

4M 2 4   

9 Explain the role of AI in HR Applications? 4M 2 5   

10 Illustrate the “Explainable AI in E-Commerce”. 4M 2 5   

 

SECTION – B 

Answer Any five Questions  5 X 10 = 50 M   

1 Explain the hardware components for building AI applications? 
(OR) 
Explain briefly about AI in applications in daily life appliances? 

10M 
 
10M  

2 
 
2 

1 
 
1 

  

2 Explain the importance of data in building AI applications? 
(OR) 
Discuss about data repositories and data licensing in AI? 

10M 
 
10M  

2 
 
2 

2 
 
2 

  

3 Summarize about Stages and Components AI Data Pipeline? 
(OR) 
b) Distinguish between Data Cleaning/Preprocessing    and Data 
Splitting? 

10M 
 
10M  

2 
 
2 

3 
 
3 
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4 Describe the Ethical Issues in AI Commerce in detail? 
(OR) 
Classify the Chatbots and Virtual Assistants in AI? 

10M 
 
10M  

3 
 
2 

4 
 
4 

  

 5 Explain the various applications of AI Business Intelligence? 
(OR) 
Explain about AI in Marketing? 

10M 
   10M  

2 
 
2 

5 
 
5 
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MODEL QUESTION PAPER (W.E.F 2025-2026): 

APPLICABLE TO COMMERCE AND MANAGEMENT 
Course Code                  Title of the Course L T P C 

25BCG202L 
25BCC202L 
25BBA202L 
25BFS202L 

 

    Applications of AI 

   
2 

 
1 

Prerequisites               Basic Knowledge in AI 

 

   Practice Session 

Lab Practicals (No Coding) 

Lab 1 - Exploring Public Datasets (Orange Data Mining)  

● Visit a public repository (Kaggle, UCI, data.gov.in)  

● Download a dataset (e.g., rainfall data, literacy rates, or traffic accident statistics)  

● Procedure: 1. Open Orange → Add File widget → Load a CSV (e.g., Titanic dataset). 2. Connect to Data 

Table → View rows/columns. 3. Connect to Data Info → Check attributes, data types. 4. View in Data 

Table and Distributions widget.  

● Observation: Note numeric, categorical, missing values.  

● Outcome: Students understand structured data format in CSV.  

Lab 2 - Understanding Dataset Metadata and Formats  

● Take two datasets in different formats (CSV, JSON)  

● View metadata (description, features, size, license)  

● Compare domain-specific datasets (e.g., medical vs. finance)  

Lab 3 - Data Annotation Exercise  

● Use MakeSense.ai or VGG Image Annotator (VIA)  

● Annotate 10 sample images (traffic signs, fruits, or medical scans)  

● Export annotations in XML or YOLO format  
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● Discuss annotation errors and challenges  

Lab 4 - Data Cleaning and Visualization (Orange Data Mining)  

● Aim: To clean dirty data and visualize categorical and numeric attributes.  

● Procedure: 1. Load dataset. 2. Connect File → Edit Domain (to change types) and Impute (to fill 

missing values). 3. Compare cleaned vs. original in Data Table. 4. Distributions widget. 5. Check various 

features distribution. (Optional: Create simple bar charts/line charts to visualize trends using Google 

Looker Studio)  

● Observation: Missing values filled with mean/median., Graphical representation of data.  

● Outcome: Learn importance of data cleaning., Students learn importance of visualization in 

preprocessing.  

Lab 5: Train/Test Split in Orange  

● Aim: To split a dataset for AI training/testing.  

● Procedure: 1. Load Titanic dataset. 2. Connect File → Data Sampler (70% train, 30% test). 3. Connect 

outputs to Data Table widgets to view.  

● Observation: Students see two different subsets.  

● Outcome: Concept of model validation using split data.  

Lab 6: Introduction to AI in Commerce – Use Case Exploration  

Prerequisite: Discuss conceptually about Clustering  

Objective: Understand how AI is applied in commerce through data visualization and clustering. Orange 

Workflow: Use Orange Data Mining Tool  

Widgets Used: File → Data Table → Scatter Plot → Hierarchical Clustering Dataset: Retail customer data 

(e.g., purchase frequency, amount spent)  

Dataset Link: Retail Sales Data  

Activities: · · · Load customer data and visualize spending patterns. Apply clustering to identify customer 

segments. Discuss how businesses can tailor services to each segment.  

Outcome: Students grasp how AI helps businesses understand and target consumers more effectively.  

Lab 7: Recommendation Engine Simulation  

Prerequisite: Discuss conceptually about Clustering  

Objective: Simulate collaborative filtering using similarity-based clustering.  

Orange Workflow:  

Widgets Used: File → Distance → Hierarchical Clustering → Data Table  
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Dataset: User-product ratings matrix  

Dataset Link: Amazon Product Recommendation System  

Activities:  

● Calculate similarity between users.  

● Group similar users and recommend products based on cluster behavior.  

● Discuss differences between collaborative and content-based filtering.  

Outcome: Students understand the logic behind recommendation systems and how they  

personalize user experience.  

Lab 8: Chatbot Intent Classification  

Prerequisite: Discuss conceptually about Linear Regression & Logistic Regression  

Objective: Train a model to classify customer queries into intents.  

Orange Workflow:  

Widgets Used: File → Preprocess Text → Bag of Words → Logistic Regression → Test & 

Score  

Dataset: Sample customer queries labeled with intents (e.g., “track order”, “return item”)  

Dataset Link: Customer Intent Classification  

Activities:  

● Preprocess and vectorize text data.  

● Train a classifier to predict query intent.  

● Evaluate accuracy and discuss chatbot training.  

Outcome: Students learn how AI understands and responds to customer queries.  

Lab 9: Sentiment Analysis of Reviews  

Prerequisite: Discuss conceptually about Naive Bayes  

Objective: Classify customer reviews as positive or negative.  

Orange Workflow:  

Widgets Used: File → Preprocess Text → Bag of Words → Naive Bayes → Test & Score  

Dataset: Product reviews with sentiment labels  

Dataset Link: Amazon Product Reviews – Sentiment Analysis  

Activities:  

● Clean and tokenize review text.  

● Train a sentiment classifier.  
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● Visualize word clouds for positive vs. negative reviews.  

Outcome: Students analyze customer feedback and extract actionable insights.  

Lab 10: Demand Forecasting with Regression  

Prerequisite: Discuss conceptually about Linear Regression & Logistic Regression  

Objective: Predict future sales using regression models.  

Orange Workflow:  

Widgets Used: File → Linear Regression → Scatter Plot → Test & Score    

Dataset: Historical sales data (e.g., monthly sales, promotions)  

Dataset Link: Comprehensive Retail Sales Data  

Activities:  

● Train a regression model to forecast sales.  

● Visualize predictions vs. actuals.  

● Discuss implications for inventory planning.  

Outcome: Students understand how AI supports demand forecasting and inventory control.  

Lab 11: Bias Detection in AI Models  

Prerequisite: Discuss conceptually about Linear Regression, Logistic Regression & Confusion  

Matrix  

Objective: Explore bias in predictive models and its impact.  

Orange Workflow:  

Widgets Used: File → Logistic Regression → Confusion Matrix → Distributions   

Dataset: HR hiring data with gender or age attributes  

Dataset Link: HR Data Analytics  

Activities:  

● Train a model to predict hiring decisions.  

● Analyze performance across demographic groups.  

● Discuss fairness, transparency, and ethical implications.  

Outcome: Students critically assess bias and propose ethical safeguards.  

Lab 12: Predictive Analytics for Business Intelligence  

Prerequisite: Discuss conceptually about Random Forest  

Objective: Use classification to predict customer churn.  

Orange Workflow:  
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Widgets Used: File → Random Forest → Test & Score → ROC Analysis  

Dataset: Telecom or subscription data with churn labels  

Dataset Link: Telco Customer Churn – IBM Dataset  

Activities:  

● Train and evaluate a churn prediction model.  

● Interpret ROC curves and accuracy.  

● Discuss how businesses can act on predictions.  

Outcome: Students apply predictive analytics to improve customer retention.  

 

Lab 13: AI in HR and Marketing – Resume Screening & Segmentation  

Prerequisite: Discuss conceptually about Clustering  

Objective: Classify resumes and segment customers using clustering.  

Orange Workflow:  

HR Task: File → Preprocess Text → Bag of Words → Logistic Regression  

Marketing Task: File → k-Means Clustering → Scatter Plot   

Resume Screening Dataset: Employee Hiring Data  

Customer Segmentation Dataset: Customer Segmentation Dataset  

Activities:  

● Screen resumes based on job fit.  

● Segment customers by behavior or demographics.  

● Discuss automation benefits and risks.  

Outcome: Students explore how AI enhances HR and marketing efficiency.  

Note: The Tools suggested above are tentative. Teacher/Student is free to choose any other  

similar tool to execute the said lab experiments. 
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DEPARTMENT OF COMMERCE 

                                    EVALUATION / ASSESSMENT PATTERN 

I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

 

EVALUATION SCHEME 

Standard Operating Procedure for Continuous Internal Assessment  (Internal Marks – 30). The 

Internal marks in all the courses/subjects will be awarded based on continuous internal 

assessment made during the semester concerned. For each Courses/subject 30 marks are 

allotted for internal assessment and 70 marks are allotted for the End Semester Examination. 

Continuous Internal Evaluation (CIA): 

It has been decided to introduce Continuous Internal assessment marks for a total of 60 marks, 

which are to be distributed as follows: 

*The Total 60 Marks is scaled down to 30 Marks* 

 

 

S.No. Component Distribution of Marks 

1 CIE - I(off line Exam after completion of 50% of syllabus) 20 

2 CIE - II(off line Exam) 20 

3 Attendance 5 

Pedagogical Strategies  

4 Assignment 5 

5 Participation or Paper Presentation by Student 

Seminars/Workshops/Group Discussions/Quiz/Student Study 

Project/Field Visit/Survey 

5 

6 Swatch Bharat (Clean & Green) 5 

TOTAL 60 
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Component I: CIE - I &CIE - II(20+20 =40 Marks) 

Two Internal Examinations, shall be conducted for assessment. These examinations will be 

conducted during August/September (CIE –I) and January/February (CIE-II). CIE-I carries 20 

marks and CIE-II carries 20 marks. CIE- I will be conducted after completion of 50% of 

syllabus. The second internal examination, i.e., CIE– II, which will cover the remaining second 

half of the syllabus. The sum of both the CIEs will be considered for awarding marks for CIA 

Component - III: Attendance (5 Marks) 

Attendance mark will be awarded to the students based on their attendance percentage on a       

particular course. Faculty of each course has to award the attendance mark based on their         

subject attendance. 

Component - IV: Assignment (5 Marks) 

One Assignment for each course must be submitted by a student in each semester. The marks 

allotted to this component will be awarded based on the performance of the student. The 

assignment topic may be assigned either individually or group. Assignment should be submitted 

by the student in the first half of the semester. Also maximum of 7 days should be given to 

students to submit the assignment. Assignments should be evaluated by the faculty concerned 

and the same to be verified by the student. The assignment should be kept in department for the 

Academic Audit by IQAC and also for external academic audit conducted by office of 

Commissionerate of Collegiate Education. The marks should be awarded by the faculty. 

Component- V( Pedagogical Strategies): 

Participation /Paper Presentation in Student Seminars/Workshops/Group Discussions/ Quiz/ 

Student Study Project/Field Visit/Survey (5 Marks). 

For this component, the marks will be provided to student, if he/she participate/win in the 

external college technical events. To score marks, the student has to participate/present papers 

related to Subject in the technical events organized in the  other  colleges/other departments in 

the college. 

In case of Classroom seminar, one seminar for each course must be presented by a student in 

each semester. Each student should be given individual topic for seminar; the student has to 

submit the seminar topic as assignment and the same will be presented minimum of 10 minutes 

in the class through ICT. The seminar presented by the student should be evaluated by the 

subject faculty and Based on the performance of the presentation, the marks will be awarded. 
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Similarly, reports on field visits, educational tours, study projects in prescribed format will be 

considered for awarding marks in this component. 

In case of Quiz, offline/online quiz, it should be conducted after the CIE II and well before the 

SEE. Faculty concerned has to announce the schedule for the quiz and conduct the quiz.  

 Semester End Examinations (SEE) 

The question paper is of 3 hrs duration for 70 marks. The suggestive question paper model is 

given that may be used for framing the question.  

 

 

   Signature of the BOS Chairman   Signature of the BOS Members   
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